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Documentation Notice

The information and software described in this document are furnished only under a separate agreement and
may only be used or copied according to the terms of such agreement. It is against the law to copy the
software except as specifically allowed in such agreement. Complying with all applicable copyright laws is
the responsibility of the user. Without limiting the rights under copyright law, no part of this document may be
reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any means
(electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express
written permission of Hyland Software, Inc. and/or one of its affiliates.

Hyland, OnBase, Alfresco, Nuxeo, Content Innovation Cloud, and other product or brand names are
registered and/or unregistered trademarks of Hyland Software, Inc. and its affiliates in the United States and
other countries. All other trademarks, service marks, trade names and products of other companies are the
property of their respective owners.

© 2026 Hyland.

The information in this document may contain technology as defined by the Export Administration
Regulations (EAR) and could be subject to the Export Control Laws of the U.S. Government including for the
EAR and trade and economic sanctions maintained by the Office of Foreign Assets Control as well as the
export controls laws of your entity’s local jurisdiction. Transfer of such technology by any means to a foreign
person, whether in the United States or abroad, could require export licensing or other approval from the U.S.
Government and the export authority of your entity’s jurisdiction. You are responsible for ensuring that you
have any required approvals prior to export.

DISCLAIMER: This documentation contains available instructions for a specific Hyland product or module.
This documentation is not specific to a particular customer or industry. All data, names, and formats used in
this document’s examples are fictitious unless noted otherwise. This document may reference websites
operated by third parties. In such a case, Hyland has no control or liability for the content of such third-party
websites. The inclusion of such a link shall not constitute an endorsement or affiliation with such a third-party
website; the reference is provided for information purposes only. If you have questions about discrepancies in
this document, please contact Hyland. Hyland customers are responsible for making their own independent
assessment of the information in this documentation. This documentation: (a) is for informational purposes
only, (b) is subject to change without notice, (c) is confidential information of Hyland Software, Inc. and its
affiliates, and (d) does not create any commitments or assurances by Hyland. This documentation is provided
“as is” without representation or warranty of any kind. Hyland expressly disclaims all implied, express, or
statutory warranties. Hyland's responsibilities and liabilities to its customers are controlled by the applicable
Hyland agreement. This documentation does not modify any agreement between Hyland and its customers.
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Manage forms

Set form privileges

To set form privileges, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Forms.

In the right pane, in the Form list, select the form you want and then click Modify.

In the Form dialog box, in the left pane, click Security.

In the right pane, in the Select a presentation box, select a presentation.

Under Users/Groups, click Add.

In the Form dialog box, under Users/Groups, select the user or group you want to grant privileges to.

In the Privileges list, click the column to the left of the Forms privilege so that it is displayed for the
following privileges as needed:

® Noar DN

« Toview the form and its data, grant the View privilege. The View privilege is required to make the
other privileges effective.

« Tomodify the data for that form, grant the Modify privilege.

« Toenter data into new instances of that form, grant the Create privilege.

« Todelete datain that form, grant the Delete privilege.

« Repeat these steps for each user and group who needs access to the form.

About creating forms in Form Designer

Form Designer allows you to create and publish forms without the need for scripting or technical development,
as well as the ability to create the fields on a form using custom properties in Perceptive Content.

Creating fields from custom properties optionally allows the system to complete custom properties using the
data a user enters in the form fields. This synchronization makes the form field data searchable.

When publishing in Form Designer, you create a document type or folder type. You can choose to
automatically populate the document keys or project name from information a user enters in form fields when
submitting a form through an embedded URL.



About defining form security

To deploy forms, you must grant the appropriate privileges to a user or group based on the type of form you
create and any security considerations.

The following examples highlight some of the more common scenarios that you may encounter. Although this
topic does not describe all of the possible associated privilege combinations for every type of form you can
create, it provides some higher level concepts to remember while creating and deploying the form. Consider
the following common scenarios for privileges when deploying forms.

Forms displayed as stand-alone documents. Stand-alone document forms appearin
ImageNowViewer or Perceptive Content Folder Viewer as the primary document. Because each form is
associated with a drawer, the user must have privileges for the drawer to access the form.

Forms displayed as supplemental information for documents or folders. Forms
associated with a document or folder appear in the Forms pane and are associated with a document or
folder in ImageNowViewer or Perceptive Content Folder Viewer.

Forms displayed as stand-alone on folders. Stand-alone forms appearin Perceptive
Content Folder Viewer. Because this form is created as a folder type, you must grant Folder Type
privileges for this type of form.

Synchronize data. In Form Designer, you can choose how to synchronize information between the
form fields and the custom properties in Perceptive Content. When a user updates the data in a form
field, the system automatically updates the corresponding custom properties for the document or folder.

Forms in a workflow. When you associate a form to a workflow queue, the workflow privileges
overwrite any Drawer or Folder privileges.

Associate a form with a workflow queue

To associate a form with a workflow queue, complete the following steps.

1.
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In Management Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Workflow.

On the Workflow tab, select a process and then click Modify.

In the Workflow Designer dialog box, select a queue and then press ENTER.
In the Queue Properties dialog box, in the left pane, click Forms.

You can perform the following associations:

« Toattach forms to this queue, click Add, in the Select Forms dialog box, select the forms you
want to add, and then click OK.

« Toremove aform from this queue, select the form in the list and then click Remove.

« Tochange the default form associated with this queue, select the form in the list and click Set as
Default.

Repeat the previous step for any additional queues.
When you are done associating forms, click OK.



Create a form

To create a new form you can build in Form Designer, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the

list.
2. Intheleft pane, click Forms.
3. Intheright pane, on the Forms tab, click New.

4. Type aunique name for your form and then press ENTER.

Delete a form

You can only delete forms that have no associated data. To delete a form, complete the following steps.
1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Forms.

Inright pane, on the Forms tab, select a form and then click Delete.

In the confirmation dialog, click Yes.
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To prevent further use of the form, if the selected form has data associated with it, in the Delete Form
dialog box, click Yes to Mark Form as inactive and retain existing form data.

Make a form active or inactive

Set a form to inactive when you want to retain and view existing data, but you no longer want users to enter or
modify form data. If you want to prevent users from using the form temporarily, revoke the user privileges for
that period of time. To make a form active or inactive, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.
2. Intheleft pane, click Forms.

3. Intheleft pane, on the Forms tab, select the form you want to make active or inactive and then click
Modify.

4. Inthe Form dialog box, in the General section, under Options, select the Is Active check box to make
the form active or clear the check box to make the form inactive.

5. Click OK.

Display or hide an inactive form

To display or hide an inactive form, complete the following steps.

1. InManagement Console, in the |eft pane, click Forms.

2. Intheright pane, on the Forms tab, select the Show inactive forms check box to display inactive
forms or clear the check box to hide inactive forms in this list.



Verify form functions

To verify that the form was loaded into Perceptive Content successfully and the code works correctly,
complete the following steps.

1. Open anitem in workflow.

2. Inthe Forms pane on the Viewer window, in the Forms list, select the available form you want to use.

Note: This step is necessary only if the form you want is not set as the default form when there is
more than one form available with that workflow queue.

3. Typedatainto all of the fields on the form and then, in Perceptive Content, on the File menu, click
Save.

This step verifies the data entry as well as any data validation you coded.

4. If the form has the ability to add or delete rows or repeat sections in a table, click those buttons to test
them.

5. If you added any JavaScript, verify the scripts.

6. Before exiting the form, click the red X to remove the data. This step prevents the form from having any
associated data, which prevents you from modifying or deleting the form files during testing.

7. If there are any errors, you must correct the errors in your local form files and then reload them into
ImageNow Server.

8. Perform this verification procedure on both the ImageNow Client and ImageNow Server to ensure
that the forms look and function the same.

Manage manual forms

About administering manual forms

You can manually create forms using external tools instead of using Form Designer. Manual forms must be
manually deployed into Perceptive Content.

If you choose not to use Form Designer to create your forms, you can use standard HTML, XSL, and XML to
create form files using external editing tools (such as Microsoft FrontPage or Adobe DreamWeaver). You can
also use external editing tools to extend the functionality of forms that you create using Form Designer, but
you must then manually deploy your form in Perceptive Content.

The following files are used in forms in Perceptive Content, although you can optionally use CSS, graphics,
and JavaScript.

Presentation Template This XSL file describes how to present the XML data in the form. You can use many
presentations with a single XML source file, so you can create different formatting or views of the data for
each form you create. Each presentation can have different security settings. Through these settings, you
can control access to your forms. Additionally, external ODBC access is provided through iScript, a scripting
language available with Perceptive Content.



Data Definition This XML file contains the schema used to save data instances in data content record files.
You can also add data to elements in this file to pre-populate fields in your form the first time it is displayed to
auser.

Data Content Record This XML file contains individual instances of form data based on a corresponding data
definition file. The data captured during form processing is stored for viewing, editing, searching, and archiving
purposes. Perceptive Content creates and maintains the data content record files for you based on your data
definition file. Perceptive Content stores these records as subobjects.

If you are using external editing tools to create form files, the system does not support files encoded with
UTF-8 with BOM.

Manually deploy a form overview

To get started manually deploying a form, complete the following sequence of procedures.

Manually upload form definition files.

Create a form.

Add a data definition and presentation to a form.
Set form privileges.

Optional. Associate a form with a workflow queue.
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Verify form functions.

Manually upload form definition files

To manually upload an XML data definition file, XSL files, supporting files, and organize your files into
presentations, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Forms.

3. Intheright pane, click Manage Components Manually.
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4. Onthe Manage Form Components dialog box, do any of the following procedures:

Situation Steps

Upload an XML data definition file 1. Inthe Data Definitions pane, click Add.

2. Inthe File Open dialog box, navigate to the
folder where your local form files are stored,
select the XML file you created for this form
and then click Open.

Upload files to share with more than one 1. Inthe Shared Files pane and then click
presentation. Add.

2. Inthe Shared Files dialog box, select the
optional files you created that you want to
share with more than one presentation and
then click Open.

Create a presentation 1. Onthe Presentations pane, click Create,
type a name for your presentation and then
press ENTER.

2. Select the presentation you just created and
click Modify.

3. Optional. In the Presentation dialog box, in
the General pane, type a description for
your presentation.

Upload an XSL file for your presentation 1. Inthe presentation, in the Files pane, click
Add, select the XSL file and any optional
files you created for this presentation.

2. Click Open.

3. If you previously added shared files that you
want to use in this presentation, click Select
Shared Files, in the Select Shared Files
dialog box, select the files you want and
then click OK.

4. If you created more than one XSL file to use
with your XML file, repeat these steps for
each XSL file.

5. Click OK.

Create aform

To create a new form you can build in Form Designer, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the



list.
2. Intheleft pane, click Forms.
3. Intheright pane, on the Forms tab, click New.
4. Type aunique name for your form and then press ENTER.

Add a data definition and presentation to a form

To define an existing data definition file and presentation for a form, complete the following steps.
Prerequisite Before completing this procedure, you must upload the data definition and presentation files.

In Management Console, on the left pane, click Forms.
In the right pane, select a form and click Modify.
In the left pane, click Components.
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In the right pane, under Data Definition, in the Data definition list box, select the XML file you created
for this form.

5. Click Select to choose presentations you want to be available for use with this form, in the Select
Presentations dialog box select the presentations and then click OK.

6. Click OK.

Set form privileges

To set form privileges, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Forms.

In the right pane, in the Form list, select the form you want and then click Modify.

In the Form dialog box, in the left pane, click Security.

In the right pane, in the Select a presentation box, select a presentation.

Under Users/Groups, click Add.

In the Form dialog box, under Users/Groups, select the user or group you want to grant privileges to.

In the Privileges list, click the column to the left of the Forms privilege so that it is displayed for the
following privileges as needed:
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« Toview the form and its data, grant the View privilege. The View privilege is required to make the
other privileges effective.

« To modify the data for that form, grant the Modify privilege.

« Toenterdata into new instances of that form, grant the Create privilege.

« Todelete datain that form, grant the Delete privilege.

« Repeat these steps for each user and group who needs access to the form.
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Associate a form with a workflow queue

To associate a form with a workflow queue, complete the following steps.

1.
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7.
8.

In Management Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Workflow.

On the Workflow tab, select a process and then click Modify.

In the Workflow Designer dialog box, select a queue and then press ENTER.
In the Queue Properties dialog box, in the left pane, click Forms.

You can perform the following associations:

« Toattach forms to this queue, click Add, in the Select Forms dialog box, select the forms you
want to add, and then click OK.

« Toremove aform from this queue, select the form in the list and then click Remove.

« To change the default form associated with this queue, select the form in the list and click Set as
Default.

Repeat the previous step for any additional queues.
When you are done associating forms, click OK.

Verify form functions

To verify that the form was loaded into Perceptive Content successfully and the code works correctly,
complete the following steps.

1.
2.

Open anitem in workflow.
In the Forms pane on the Viewer window, in the Forms list, select the available form you want to use.

Note: This step is necessary only if the form you want is not set as the default form when there is
more than one form available with that workflow queue.

Type data into all of the fields on the form and then, in Perceptive Content, on the File menu, click
Save.

This step verifies the data entry as well as any data validation you coded.

If the form has the ability to add or delete rows or repeat sections in a table, click those buttons to test
them.

If you added any JavaScript, verify the scripts.

Before exiting the form, click the red X to remove the data. This step prevents the form from having any
associated data, which prevents you from modifying or deleting the form files during testing.

If there are any errors, you must correct the errors in your local form files and then reload them into
ImageNow Server.

Perform this verification procedure on both the ImageNow Client and ImageNow Server to ensure
that the forms look and function the same.
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Manually modify form settings

To manually modify form settings, complete the following steps.

Prerequisite A Forms license is required to use forms. If you need a Forms license, contact your Perceptive
Software representative.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Forms.

3. Intheright pane, select a form and then click Modify.

4. Inthe Form dialog box, you can make the following changes to your form:

« Inthe General pane, you can modify the form name, description, and set the form to active or
inactive.

« Inthe Components pane, you can change the data definition file to use with this form and which
presentations are available for this form.

« Inthe Security pane, you can grant or deny form privileges to users and groups.
5. When you are done modifying the form, click OK.

Manually modify form components

To manually modify form components, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Inthe left pane, click Forms.

3. Intheright pane, on the Forms tab, click Manage Components Manually.

4. To modify data definitions, complete the following substeps:

1. Toreplace a data definition file, select the existing data definition in the forms list and then click
Replace.

2. Inthe Replace confirmation dialog box, click Yes.
5. Navigate to the XML file you wish to use to replace the existing one and then click Open.

Note: Replacing your data definition file can cause existing XML instances to become corrupted. This
is especially true if you have moved or modified an existing element. Adding new elements should not
corrupt data, but the elements in the existing XML instances will not be populated, so you need to
populate them.

6. Toremove a data definition file, select the existing data definition in the form list and then click
Remove.

Note: Changes to form files do not affect users who are currently logged in until they log out and in
again.

7. Toreplace an optional file, select the existing file in the list and then click Replace.



10.
11.

12.
13.

14.

15.
16.
17.
18.

19.

In the Replace confirmation dialog box, click Yes.

Navigate to the file you wish to use to replace the existing one and then click Open.
Toremove afile, select the existing optional file in the list and then click Remove.
To modify a presentation, select the presentation in the list and click Modify.

Note: Changes to form files do not affect users who are currently logged in until they log out and in
again.

In the General pane, you can change the presentation name and description.

In the Files pane, to add files to an existing presentation, click Add, navigate to the file and then click
Open.

To add shared files on the ImageNow Serverto the presentation, click Select Shared Files, select the
files and then click OK.

Toreplace afile, select the file in the list, click Replace, navigate to the new file and then click Open.
Toremove afile, select the file in the list and then click Remove.

In the Presentation dialog box, when you are finished making changes, click OK.

To remove a presentation, select the presentation in the list and click Remove.

Note: Changes to form files do not affect users who are currently logged in until they log out and in
again.

When you are finished modifying components, click OK.

Manually add a form to a document type

To select a form to associate with a document displayed in ImageNowViewer complete the following steps.

1.

5.

In Management Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Document Types.
Select a document type and then click Modify.

In the Document Type dialog box, in the General tab, check the Is a form check box, and then select
aform in the Form list.

Click OK.

Manually add a form to a folder type

To select an existing form to associate with a folder displayed in Perceptive ContentFolder Viewer, complete
the following steps.

1.

2.
3.

In Management Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Folder Types.
Select a folder type name and click Modify.



4. Inthe Folder Type dialog box, in the General tab, check the Is a form check box, and then select a
form in the Form list.

5. Click OK.

Result Whenever you create a new folder based on this folder type, you must add it to a workflow queue.
Otherwise, the user of folder cannot access it.

Manually upload form definition files

To manually upload an XML data definition file, XSL files, supporting files, and organize your files into
presentations, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Forms.

3. Intheright pane, click Manage Components Manually.



4. Onthe Manage Form Components dialog box, do any of the following procedures:

Situation Steps

Upload an XML data definition file 1. Inthe Data Definitions pane, click Add.

2. Inthe File Open dialog box, navigate to the
folder where your local form files are stored,
select the XML file you created for this form
and then click Open.

Upload files to share with more than one 1. Inthe Shared Files pane and then click
presentation. Add.

2. Inthe Shared Files dialog box, select the
optional files you created that you want to
share with more than one presentation and
then click Open.

Create a presentation 1. Onthe Presentations pane, click Create,
type a name for your presentation and then
press ENTER.

2. Select the presentation you just created and
click Modify.

3. Optional. In the Presentation dialog box, in
the General pane, type a description for
your presentation.

Upload an XSL file for your presentation 1. Inthe presentation, in the Files pane, click
Add, select the XSL file and any optional
files you created for this presentation.

2. Click Open.

3. If you previously added shared files that you
want to use in this presentation, click Select
Shared Files, in the Select Shared Files
dialog box, select the files you want and
then click OK.

4. If you created more than one XSL file to use
with your XML file, repeat these steps for
each XSL file.

5. Click OK.

Add a shared form file

To manually add shared form files into Perceptive Content, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
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6.

list.

In the left pane, click Forms.

In the right pane, click Manage Form Components.

In the Manage Form Components dialog box, in the left pane, click Shared Files > Add.

In the File Open dialog box, navigate to the folder where your local form files are stored, select the files
you want to add and then click Open.

Click OK.

Remove a shared form file

To remove shared files from a form, complete the following steps.

1.
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In Management Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Forms.

In the right pane, click Manage Components Manually.

Inthe Manage Form Components dialog box, in the left pane, click Shared Files.

In the list of shared files, select the shared files you want to remove and then click Remove.
Click OK.

Troubleshoot a form

Use the following information to troubleshoot a form.

Error Messages

Message Resolution

XML page cannot be displayed If this error appears in the Forms pane, Perceptive

Content cannot transform the files due to an errorin
your XML or XSL file. Correct the errors and then re-
load the files into Perceptive Content.

JavaScript errors

If JavaScript does not execute successfully in your form, try one of these possible resolutions.

Cause Resolution

Comments are formatted incorrectly. For Perceptive Content, you cannot use // to denote

comments in your JavaScript, use /* */ instead.




Cause Resolution

A browser component is not supported. Perceptive Content does not support a full browser
environment, so plug-ins such as Active X, Java
applets, and Flash are not supported as part of a
form.

Unable to find or view forms

If you are unable to find a form in Perceptive Content or view the form in ImageNowViewer, try one of the
following possible resolutions.

Cause Resolution

The Forms pane is not displayed in Click View > Forms.
ImageNowViewer.

Manage item properties

What is a custom property?

A custom property is a property field that is populated with data relating to an item or container.

A custom property allows you to store unlimited data beyond the standard item properties or container
structure. You make custom properties available to items and containers by assigning them to item types or
container types.

You can define a custom property using one of the following data types: Composite, Date, Flag, List, Number,
String, and User. Formatting settings let you control the data entry and display appearance of the custom
property for viewing by your end users. If you choose the Composite data type, you can create a composite
property that is a single property that contains one or more custom properties. Some data types require default
values. For others, default values are optional.

Suppose, for example, that the Human Resources Department has a "New Hire" folder type that is used to
create a folder for each new employee. When Human Resources hires a new Marketing director, the user
creates a new folder using the New Hire folder type and enters the following custom property values in
Perceptive Content for the folder:

« A string custom property for "Job Title" with the value "Marketing Director".

« A date custom property for "Date of Hire" with the value "05/08/2012".

As another example, a document assigned with the "Medical Enrollment Form" document type is added to
each new employee's folder. When the new employee completes the form, the user enters the following
custom property values in Perceptive Content for the document:




A list custom property for "Plan Year" with the value "2012".
A date custom property for "Coverage Start Date" with the value "06/01/2012".

What is a composite property?

A composite property allows you to store multiple values or sets of values that are based on one or more
existing custom properties, and group and refine the metadata that your users use to describe the documents
and folders in your system.

Composite properties also allow users to store differing numbers of values in a single property. In the custom
properties of a document or folder, the user can add values to, change existing values in, or remove values
from a composite property at any time.

You can perform a search to locate documents, folders, and workflow items based on composite property
values just as you would when searching on any document or folder property.

The following examples show how you might use composite properties:

You define a composite property to store values using a single custom property. In this example,
suppose you are tracking test scores for a student. Whenever a student repeats a test, the user tracking
the test scores must add the new score to the Test Results property in that student's document. For one
student, the score might contain one value, and for another it may contain fifteen values.

You define a composite property to store sets of values using multiple custom properties. Expanding on
the previous example, suppose the user tracking the test scores needs to enter a date along with each
test score and a flag value that indicates whether a retest is required. This expanded Test Results
property contains one property set for a student who has taken the test only once, but for a student who
has taken the test and then retested five times, it contains six property sets, each with its own score,
date, and retest values.

Create a custom property overview

To create a custom property you can assign to a document or folder type or use as part of a composite
property, complete any of the following procedures.

Create a date custom property.
Create a flag custom property
Create alist custom property
Create a number custom property.
Create a string custom property.
Create a user custom property.

Create a date custom property

To create a custom property that stores a date value, complete the following steps.

1.

2.

In Management Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Custom Properties.
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3. Intheright pane, click New > Date.
4. Inthe New Date Property dialog box, in the Name box, type the name of the custom property.
5. In Default value list, do one of the following options:
« Touse the current date as the default value, select the Default to the current date check box.

« Toselect adate to use as the default value, clear the Default to the current date check box and
select the desired default date in the Default value list.

« Touse no default value, leave the default value empty and clear the checkbox.

6. Inthe Display Format section, select the Month, Day, Year, and Weekday check boxes to show the
respective portion of the date.

7. Click OK.

Next You can assign the custom property to a document type, folder type, record type, record folder type, or
composite property.

Create a flag custom property

To create a custom property that stores a flag, or boolean value, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Custom Properties.

Click New > Flag.

Inthe New Flag Property dialog box, in the Name box, type a name for the custom property.
Optional. In the Default value list, select True or False for the default value for this custom property.
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Note: If you leave this setting empty, no default value appears in the custom property.

6. Inthe Positive Label box, type the value to display when the condition is true.
7. Inthe Negative Label box, type the value to display when the condition is false.

Note: The Flag property stores values of 0 or 1 based on the value that is selected by the user. The
Positive Label and Negative Label boxes allow you to adjust the labels that represent the stored
values.

8. Click OK.
Next You can assign the custom property to a document type, folder type, or composite property.

Create a list custom property
To create a custom property that stores a value from a predefined list, complete the following steps.

Prerequisite This procedure requires the Global > Manage > Custom Properties privilege.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Custom Properties.
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6.
7.

In the right pane, click New > List.

Inthe New List Property dialog box, in the Name box, type a name for the custom property.

To add items to the list, do the following substeps:

1.

2.
3.
4

Under Display Format, in the Values list, click Add.
Type the value for the list item and then press ENTER.
Repeat the previous substeps for each value you want to display in the list.

Optional. After you add all list items, use the Move Up and Move Down buttons to rearrange the
order of the list items.

Optional. In the Default value list, select the default list item value for this custom property.
Click OK.
Next You can assign the custom property to a document type, folder type, or composite property.

Create a number custom property

To create a custom property that stores a numeric value, complete the following steps.

1. InManagement Console, in the left pane, click Custom Properties.
2. Intheright pane, click New > Number.
3. Inthe New Number Property dialog box, in the Name box, type a name for this custom property.
4. Optional. In the Default value box, type the number to use for the default value for this custom
property.
5. Under Display Format, complete the following substeps.
1. Inthe Formatlist, select Currency or Decimal.
Note: Select Currency format for currency values and Decimal format for standard numeric
values.
2. If you are using Currency format, select the currency type from the list.
3. Ifyou are using Decimal format, select whether the decimals are Fixed or Varying.
4. If you are using Decimal format, in the Decimal Places box, type or select the number of
decimal places.
Note: If you are using a varying decimal value for a numeric value, you cannot set the number of
decimal places.
5. Optional. To remove the thousands separator from numbers greater than 999, clear the
Punctuated at thousands check box.
6. Click OK.

Next You can assign the custom property to a document type, folder type, or composite property.
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Create a string custom property
To create a custom property that stores a string value, complete the following steps.

In Management Console, in the left pane, click Custom Properties.

In the right pane, click New > String.

Inthe New String Property dialog box, in the Name box, type a name for the custom property.
Optional. In the Default value box, type the default string value for this custom property.

Click OK.

Next You can assign the custom property to a document type, folder type, or composite property.
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Create a user custom property

To create a custom property that stores a username value, complete the following steps.
Prerequisite This procedure requires the Global > Manage > Custom Properties privilege.

In Management Console, in the left pane, click Custom Properties.
2. Intheright pane, click New > User.

3. Inthe New User Property dialog box, in the Name box, type a name for the custom property, and then
do one of the following options:

« Toselect user values from a group, complete the following substeps.

1. Inthe Source list, select Group.

2. Inthe Group list, select the group.

To select user values from a predefined list, complete the following substeps.

1. Inthe Source list, select Predefined list.

2. Click Add.

3. Inthe Select Users dialog box, search for and select the users you want to add to the list and
click OK.

4. Reorder the list members as necessary.
4. Optional. Inthe Default Value list, select the default user.
5. Under Display Format, in the Format list, select a display format.

6. Optional. If you selected a display format other than User name, to display the prefix or suffix in the
user s user profile when displaying this custom property, select the Display prefix and Display suffix
check boxes.

7. Click OK.
Next You can assign the custom property to a document type, folder type, or composite property.
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Assign a custom property to a document type

To assign a custom property to a document type, complete the following steps.

Prerequisite Because assigning a custom property to a document type that is already in use can take a long
time, cause a potentially unacceptable delay, and use significant resources, we recommend you perform this
procedure during non-peak hours.

1. InManagement Console, in the left pane, click Document Types.

2. Onthe Document Types tab, select the document type for which you want to assign a custom
property and then click Modify.

3. Optional. In the Document Type dialog box, on the Custom Properties tab, to filter the available
custom properties by data type, in the By Type list, select the data type you want.

4. Inthe Document Type dialog box, on the Custom Properties tab, in the Available list, select the
custom property you want to add, click Add, and then, on the Add Custom Properties confirmation
dialog box, click Yes.

5. Ifthe document type is already in use, in the Add Custom Property dialog box, determine how to
populate existing custom property values for all documents that are assigned any document types that
use this custom property:

« Select Use the Default Value assigned to this property to automatically populate existing custom
properties with the default value you specified when you created the custom property.

« Select Leave blank to populate existing custom properties with no value.
« Select Use to type or select a value to populate existing custom properties.

6. Click OK and, if you receive another confirmation dialog box indicating the update could take a long
time and use significant resources, click Yes only if you are sure this will not create an unacceptable
delay. Otherwise, click No or Cancel and repeat the procedure during non-peak hours.

7. Optional. To make a custom property required, in the Added list, click once in the column in front of the
custom property until is displayed. A required custom property must contain a value whenever the
associated item is linked or you change the document type of the associated document.

Assign a custom property to a folder type

To assign a custom property to a folder type, complete the following steps.

In Management Console, in the left pane, click Folder Types.
2. Onthe Folder Types tab, in the Folder Type list, select the folder type for which you want to assign a
custom property and click Modify.

3. Optional. Inthe Folder Type dialog box, on the Custom Properties tab, tofilter the available custom
properties by data type, in the By Type list, select the data type you want.

4. Inthe Folder Type dialog box, on the Custom Properties tab, in the Available list, select the custom
property you want to add, click Add, and, on the Add Custom Properties confirmation dialog box,
click Yes.

5. Ifthefile typeis already in use, in the Add Custom Property dialog box, determine how to populate
existing custom property values for all folders that are of folder types that use this custom property:

« Select Use the Default Value assigned to this property to automatically populate existing custom



properties with the default value you specified when you created the custom property.
« Select Leave blank to populate existing custom properties with no value.
« Select Use to type or select a value to populate existing custom properties.

6. Click OK, and if you receive another confirmation dialog box indicating the update could take a long
time and use significant resources, click Yes only if you are sure this is not an issue. Otherwise, click
No or Cancel and repeat the procedure during non-peak hours.

7. Optional. To make a custom property required, in the Added list, click once in the column in front of the
custom property. The Required icon appears. A required custom property must contain a value
whenever the associated item is linked or you change the folder type of the associated document.

Modify a custom property

To change settings for an existing custom property, complete the following steps.

1. InManagement Console, in the left pane, click Custom Properties.
2. Intheright pane, select the custom property you want to modify, and then click Modify.
3. Inthe Modify <Property Type> Property dialog box, make your changes and then click OK.

Delete a custom property

To delete a custom property, complete the following steps.

Because deleting a custom property that is already in use can take a long time, cause a potentially
unacceptable delay, and use significant resources, we recommend you perform this procedure during non-
peak hours.

1. InManagement Console, in the left pane, click Custom Properties.

2. Intheright pane, select the custom property you want, and click Delete.

3. Onthe Delete Property dialog box, click Yes.

Custom property data types

You can choose from the following data types when you create a custom property. All custom property types
can have a default value or contain an empty (or NULL) value.

If you select a single
custom property, the
user can add multiple

Data Type Name Data Type Description Value Restrictions
Composite Inherits types from A composite property Values must conform to
custom properties allows the user to enter the data types of the
multiple values for a associated custom
single property. properties.




Data Type Name

Data Type

Description

Value Restrictions

values of the same data
type to the composite.
The values appear as
numbered rows in the
Custom Properties pane
of the Viewer.

If you select multiple
custom properties, the
user can add multiple
property sets of the
composite with separate
sets of values for each
set. Property sets
appear as separate
hierarchies in the
Custom Properties pane
of the Viewer.

Date

Date field

A date stored as a
string. The displayed
date format is based on
the settings chosen
when you create the
custom property.

Not applicable.

Flag

Boolean field

This data type is always
stored as TRUE (1) or
FALSE (0). The values
that display are based
on the settings chosen
when creating the
custom property.

1 or 0 but the display
strings that represent
the 1 can be altered.

List

Predefined List

This data type creates a
group of values that a
user can select from a
list box for the custom
property.

Not applicable.

Number

Decimal number field

Decimal data type
display format: Number
fields that support both
positive and negative

Up to 16 digits.
Precision of 15 decimal
places.




Data Type Name

Data Type

Description

Value Restrictions

numbers up to a limited
number of digits. Zeros
to the right of the
decimal are suppressed.

Currency data type
display format: Number
fields that display as
currency defined using
one of the ISO 4217
country codes. The
default currency setting
matches the local
settings of the
ImageNow Client
computer.

String

Text field

Text fields that support
all printable ASCII
characters within the
Single Byte character
set.

Value can contain up to
128 characters. This
limit varies depending
on your database
platform.

User

User name

This data type allows
you to select an
Perceptive Content user
to populate the custom
property.

Only Perceptive Content
users that currently exist
in the implementation.

Create a composite property

To create a composite property, complete the following steps.

1.
2.
3.

In the right pane, click New > Composite.

In Management Console, in the left pane, click Custom Properties.

In the New Composite Property dialog box, in the Name box, type the name of the composite
property and do the following substeps:

1. Optional. In the By Type list, select the data type of the custom property you want to add.

2. Inthe Available list, select a custom property you want to include in the composite custom
property and then click Add.

the property you want to reorder and then click Move Up or Move Down.

Click OK.

Repeat the previous substeps until you have added all the custom properties you need.
Optional. To reorder the hierarchy of custom properties within the composite, in the Added list, select




Next You can assign the composite property to a document type, folder type, record type, or record folder
type.

Modify a composite property

To change the name of a composite property or modify the custom properties associated with it, complete the
following steps.

1. InManagement Console, in the left pane, click Custom Properties.

2. Intheright pane, select the composite property you want to modify.

3. Tochange the name of the composite property, in the Modify Composite Property dialog box, in the
Name box, edit the name of the composite property.

4. Toview a single custom property type in the Available list, in the By type list, select a property type.

5. Inthe Available list, select any additional custom properties you want to include in the composite
property and then click Add.

6. Torearrange the hierarchy of custom properties within the composite, in the Added list, select the
property you want to move and then click Move Up or Move Down.

7. Toremove a custom property from the composite, in the Added list, select the property and then click
Remove.

8. Click OK.

Manage processes

Tasks

About administering tasks

To administer tasks in Management Console, you create task templates for your users.

You can assign one or more users a task on a particular document or folder. You choose the task type that
best matches the work that needs to be done. The three available task types are described below.

o Document deficiency. The document deficiency task type is used to indicate when a document is
missing or is incomplete.

o Pointer. The pointer task type is used to draw attention to a specific document or folder location for
further action.

e Signature required on document. The signature required on document task type is used when a
user needs to digitally sign a document. To use this task type, a Document Management Suite license is
required.

Task template security allows you to determine the roles your users have when working with tasks. You can
also manage reasons and reason lists for the task templates.

Signatures required on document tasks created in Management Console are available for processing in
Interact Desktop. In Interact Desktop, you can Complete, Return, or Skip a Signature required on a document
task.



Troubleshoot tasks

If you experience issues using tasks, you can try any of the following possible resolutions.

| don tsee a documenttask in Folder Viewer

Cause Resolution

If you create a document task and then add that Only document tasks you create in Folder Viewer
document to a folder, the document task does not appear in the Tasks grid in Folder Viewer.
appear in the Tasks grid in Folder Viewer.

Not all location options are available when | create a task

Cause Resolution
The task template you are using to create a task Use a different task template or select an available
does not have the Task location set in the location option.

Components area of the task template.

When you are in Folder Viewer and do not have a To create a document or page task in Folder Viewer,
document open in ImageNowViewer - Folder, the the associated viewer, ImageNowViewer- Folder
only Location option available is Folder. must be open.

When in ImageNowViewer, Folder is unavailable Folder is only available when you create a task in
because you are not in a folder. Folder Viewer.

Task Templates

Create a document deficiency task template overview

Document deficiency task templates define the structure of document deficiency tasks, which indicate when
a document is missing or incomplete. To create and define a document deficiency task template, complete
the following sequence of procedures.

Create a document deficiency task template.

Define task template properties.

Define task template components.

Optional. Define task template actions.

Define task template assignments.

Define task template reasons.

Define task template due date method.
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Define task template security.



Create a signature required task template

To create a new signature required task template, complete the following steps.

1.

In Management Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Tasks.

In the right pane, on the Templates tab, in the Select a task type box, click Signature required on
document.

Click New.
The Signature Required on Document Task dialog box appears.

Next You must define the task template s general properties, components, actions, assignments, reason
lists, due date, and security.

Create a pointer task template overview

To create a pointer task template, complete the following sequence of procedures.
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Create a pointer task template.

Define task template properties.

Define task template components.
Optional. Define task templace actions.
Define task template assignments.
Define task template reasons.

Define task template due date method.
Define task template security.

Result The Incomplete Template dialog box appears if you do not define assignments, reason lists, or if you
opted to send the folder to workflow when the task location is a document in a folder box, but did not select a
queue. You can save this template in any of these states, but the template is set to inactive.

Modify a task template overview

To make changes to a task template, complete the following steps.
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Open a task template.

Define task template properties.
Define task template components.
Optional. Define task template actions.
Define task template assignments.
Define task template reasons.

Define task template due date method.
Define task template security.



Copy a task template

Task templates specify various options for task creation. To copy a task template, complete the following
steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Tasks.

In the right pane, on the Templates tab, in the Select a task type box, click a task type.

In the Templates list, click a template and then click Copy.
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In the Name column, type a name and then press ENTER.

Rename a task template

To assign a new name to a task template, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Tasks.

In the right pane, on the Templates tab, in the Select a task type box, click a task type.

In the Templates list, click a template and click Rename.
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In the Name column, type the text of the template name and then press ENTER.

Delete a task template

When you delete a task template, Perceptive Content removes the template from Management Console but
retains all associated tasks. To delete a task template, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

In the left pane, click Tasks.

In the right pane, on the Templates tab, in the Select a task type box, click a task type.

In the Templates list, click a template and then click Delete.
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In the Task Template dialog box, click Yes.

Configure task email notifications

To configure the options required for task creation email notifications, complete the following steps.
1. Toadd email addresses so that users can receive task creation notifications, perform the following
substeps.

1. In Management Console, in the left pane, under Select Department, select a department from
the list.

2. Inthe left pane, select Users.

In the right pane, on the User Profiles tab, select the user for whom you want to add an email
address and then click Modify.



In the Modify User Profile dialog box, in the left pane, select Contact Information.
In the right pane, in the Email box, type the user's email address.

Click OK.

Define email addresses for all necessary users.
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2. Toconfigure Perceptive Content Notification Agent to send email notifications, perform the following
substeps.

1. OnthelmageNow Server computer, navigate to the [drive:]\inserver\etc folder.
2. Open the inserverNotification.ini file in a text editor.
3. Inthe Email section, configure the smtp.server.url setting.

Example smtp.server.url=<smtp or smtps>://<SMTP server name or IP
address>:<port number>

4. Configure the smtp. from address.
Example smtp.from=<From address for email notifications>

5. Save and close the inserverNotification.inifile.
Result All task templates use the same Perceptive Content settings.

Task Reasons

About managing task reason lists

Reasons provide users with pre-set descriptions that they can select to indicate why they are signing,
completing, or returning a task.

A reason list is a set of reasons that you, the administrator, bundle as a list from which the user can select.
There are two types of reasons and reason lists: Action and Retumn. While Return reasons are required for
each task template type, Action reasons are optional for document deficiency and pointer task template

types.
Manage reasons

You can create reasons and then group them together in reason lists. You can assign reasons and reason lists
to tasks, workflow item holds, or digital signatures. To create, modify, or delete a reason, complete one of the
following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, complete one of the following steps.

1. To manage reasons for tasks or workflow item holds, under Select Department, select a
department from the list.

2. Tomanage reasons for digital signatures, under Select Department, select Cross Department
Settings.

3. Inthe left pane, click Tasks, Workflow, or Digital Signatures.
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4.
5.

In the right pane, on the Reason Lists tab, select a reason list and click Modify.
In the Reason List dialog box, on the List Members tab, complete one of the following actions.

Situation Steps

Create a reason 1. Click New.
2. Inthe Reason text box, type a name.

Modify a reason 1. Select a reason and click Modify.
2. Inthe Reason text box, type a new name.

Delete a reason 1. Select a reason and click Delete.

2. Inthe Delete Reason confirmation box,
click Yes.

Result Changes you make to the available reasons apply to all departments.

Modify a reason list

Reason lists are used when you define action and return reasons in document deficiency and pointer task
templates. To modify an reason list for a task template, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.
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In the left pane, click Digital Signatures.
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In the right pane, on the Reason Lists tab, perform one of the following actions, depending on the
situation.

Select the reason list and click Modify.

In the Reason List dialog box, on the General tab, change the name or description.
To enable or disable the list, clear or select the Is active check box.

On the List Members tab, in the Selected list, add, remove, or rearrange reasons.
Click OK.
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Manage a reason list for a task template

Reason lists are used when you define action and return reasons in document deficiency and pointer task
templates. To create, modify, or delete a reason list for a task template, complete one of the following
procedures.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Tasks.

3. Intheright pane, on the Reason Lists tab, do one of the following actions, depending on the situation:



Situation

Steps

Create a reason list

Click New.

2. Inthe Reason List dialog box, on the
General tab, type a name and optional
description.

3. Verify that the Is active check box is
selected to make the list available for
assignment.

4. Onthe List Members tab, add, remove, or
rearrange reasons.

5. Click OK.

Modify a reason list

Click Modify.

2. Inthe Reason List dialog box, on the
General tab, modify the name or optional
description.

3. To enable or disable the reason list, clear or
select the Is active check box.

4. Onthe List Members tab, add, remove, or
rearrange reasons.

5. Click OK.

Delete a reason list

Click Delete.

2. Inthe Delete Reason List confirmation
box, click Yes.

Manage action reason lists for a signature required task template

To create, modify, or delete an action reason list for a signature-required task template, complete the following

steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the

list.

2. Inthe left pane, under Select Department, select Cross Department Settings from the list.

3. Inthe left pane, click Digital Signatures.

4. Intheright pane, on the Reason Lists tab, perform one of the following actions, depending on the

situation.




Situation Steps

Create a reason list 1. Click New.

2. Inthe Reason List dialog box, on the
General tab, type a name and optional
description.

3. Verify that the Is active check box is
selected to make the list available for
assignment.

4. Optional. On the List Members tab, in the
Available list, create, modify, or delete
reasons.

5. Onthe List Members tab, in the Selected
list, add, remove, or rearrange reasons.

6. Click OK.

Modify a reason list 1. Click Modify.

2. Inthe Reason List dialog box, on the
General tab, change the name or
description.

3. Toenable or disable the list, clear or select
the Is active check box.

4. Optional. On the List Members tab, in the
Available list, create, modify, or delete
reasons.

5. Onthe List Members tab, in the Selected
list, add, remove, or rearrange reasons.

6. Click OK.

Delete a reason list 1. Select a reason list and click Delete.

2. Inthe Delete Reason List confirmation
box, click Yes.

Workflow

About administering workflow processes

Perceptive Content Workflow lets you automate business processes and create review checkpoints.

After you have saved a document, the document can be routed through any number of queues, which might
represent different departments or different desks within a department.



You enter Workflow Designer to create or modify workflow processes. Other workflow administration tasks
are done through Management Console, such as deleting workflow processes, assigning workflow privileges,
and handling reason lists.

Create a workflow process

A workflow process contains a series of tasks and rules reflecting the review path a workflow item must take
in order to meet the sign off and approval requirements of your work group. To create a workflow process,
complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Inthe left pane, click Workflow.

3. Intheright pane, on the Workflow tab, click New.

4. Inthe Add Process dialog box, type a name and an optional description.
The description appears in the ToolTip for the process.

5. Click OK.

Next Create queues, routes, and rules to define the components in your new workflow process in Workflow
Designer.

Modify a workflow process

To modify a workflow process, complete the following steps.
Prerequisite All other users must close the process.
1. InManagement Console, in the left pane, under Select Department, select a department from the
list.
2. Intheleft pane, click Workflow.

3. Intheright pane, on the Workflow tab, select a process and then click Modify.
4. When you are finished modifying your workflow process, close Workflow Designer.

Rename a workflow process

To change the name of a workflow process, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Workflow.

3. Intheright pane, on the Workflow tab, select a process and then click Rename.

4. Enteranew name for your process.
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Delete a workflow process

To delete a workflow process and remove all workflow items in its associated queues from workflow,
complete the following steps.

Prerequisite All users must close the process before it can be deleted.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Workflow.

3. Onthe Workflow tab, select a process and then click Delete.

4. Inthe Delete Process confirmation box, to remove items from the queues in this process and then
delete the process, select the Remove all items from workflow and then delete this process
check box and then click Yes.

Reasons

What is a reason list?

Reason lists provide users the ability to indicate why they are putting a workflow item on hold.

When putting an item on hold in a workflow queue, users are prompted to select a reason from a reason list.
As manager of a workflow process, you control the contents of every On Hold reason list. You can define a
reason list as part of a workflow queue's properties.

Add a reason list for putting an item on hold

When putting an item on hold in a workflow queue, the user must select the reason for the change from a
reason list. To create and edit a reason list, complete the following steps.

1. Complete one of the following actions, depending on the situation.

Situation Steps

Create a hold reason list in Perceptive Content 1. In Management Console, in the left pane,
under Select Department, select a
department from the list.

2. Inthe left pane, click Workflow.
3. Onthe Reason Lists tab, click New.

Create a hold reason list in Workflow Designer | 1. In Workflow Designer, double-click the
queue.

2. Inthe Queue Properties dialog box, click
Reasons > New.




2. Inthe Reason List dialog box, type a name and optional description for the reason list and then leave
the Is active check box selected.

3. Onthe List Members tab, add, remove, and rearrange reasons as necessary.
4. Click OK.

Modify or rename a reason list for putting an item on hold

Reason lists are created to provide users with predefined reasons for putting workflow items on hold. To
modify a reason list for putting an item on hold, complete the following steps.

1. Complete one of the following actions, depending on the situation.

Situation Steps
Modify a hold reason list in Management 1. In Management Console, in the left pane,
Console under Select Department, select a

department from the list.
2. Inthe left pane, click Workflow.
Click the Reason Lists tab.

4. Click the list you want to change and then
click Modify.

Modify a hold reason list in Workflow Designer | 1. Double-click the queue.

2. Inthe Queue Properties dialog box, click
Reasons in the left pane.

3. Inthe Select a reason list to use when
placing items On Hold in this queue list,
click the list you want to change and then
click Modify.

2. Inthe Reason List dialog box, on the General tab, change the name and description if necessary.

Note: You cannot change the name of a system list (Apply Signature, Void/Expire Digital ID, or Void
Signature).

3. Tomake the reason list inactive, clear the Is active check box.
Note: You cannot disable a system list.

4. Inthe List Members tab, add, remove, or rearrange reasons.
5. Click OK.



Delete a reason list for putting an item on hold

To delete a reason list for putting an item on hold, complete the following steps.

You cannot remove a system list (Apply Signature, Void/Expire Digital ID, or Void Signature).

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.

2. Intheleft pane, click Workflow.

3. Click the Reason Lists tab.

4. Click the reason list you want to delete and then click Delete.

Output Profiles

What is an output profile?

An output profile allows you to save output packaging configuration settings for reuse.

After you create an output profile, the system automatically sets the settings each time you select an output
method and an associated profile. You can create, modify, and delete output profiles for all four output
methods: email, fax, file, and print.

Although output packaging can handle large and complex output jobs, it is a client-side process designed for
smaller, ad-hoc output jobs. Outputting a large job may take several minutes to complete. The system notifies
you when the process starts and ends. Until then, you can continue to work in Perceptive Content.

For large and complex output jobs, consider using Output Agent, a server-side process that allows you to
output items on a job-by-job basis or in a batch.

Create an email output profile overview

To create an output profile users can specify when emailing items, complete the following sequence of
procedures.
1. Create an output profile.
2. Add auser or group to an output profile.
3. If emailing attachments, complete one of the following procedures.
« Output items as a single PDF
o Output item as a multi-page TIFF
4. If emailing attachments: Define output content settings.
5. Activate an output profile.

Create a fax output profile overview

To create a fax output profile, complete the following sequence of procedures.

1. Create an output profile.
2. Add auser or group to an output profile.
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3. Define fax settings for an output profile.
4. Define output content settings.
5. Define document type output order.
This procedure only applies to documents.
6. Activate an output profile.

Create a file output profile overview

To create an output profile that allows users to export items to a file, complete the following sequence of
procedures.
1. Create an output profile.
2. Addauserorgroup to an output profile.
3. Define file settings for an output profile.
4. Perform one of the following content options.
o Output items as individual files.
o Output item as a multipage tiff
« Output items as a single PDF.
5. Optional. Create a folder hierarchy for output files.
6. Define output content settings.
7. Define document type output order.
This procedure applies only to documents.
8. Activate an output profile.

Create a print output profile overview

To create a print output profile users can select when printing items, complete the following sequence of
procedures.

1. Create an output profile.

2. Addauserorgroup to an output profile.
3. Define output content settings.

4. Define document type output order.

Note: This procedure applies only to documents.
5. Activate an output profile.

Define page rotation for printing

To define whether the system automatically rotates a page image when the page orientation does not match
the printer sheet orientation, complete the following steps.

1. Intheimagenow.inifile under [Printer], for the printer.rotate.to.best.fit setting, type one of the
following options.
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« TRUE to rotate page images to match printer sheet orientation.
« FALSE to maintain the page image during printing.
The default setting is FALSE.

2. Saveand close thefile.

Copy an output profile

To copy an output profile, complete the following steps.

In Management Console, in the left pane, click Output Profiles.
In the right pane, click the appropriate output method tab.
Select the output profile and then click Copy.

A OON -

Delete an output profile

To delete an output profile, complete the following steps.

In Management Console, in the left pane, click Output Profiles.
In the right, click the appropriate output method tab.

Select the output profile and then click Delete.

4. Inthe confirmation prompt, click Yes.

W N =

Modify an output profile

To modify settings of an output profile, complete the following steps.

In Management Console, in the left pane, click Output Profiles.
In the right pane, click the appropriate output method tab.

Select the profile and then click Modify.

Modify the output profile settings.

Click OK.

O kN -=

Rename an output profile
To rename an output profile, complete the following steps.

In Management Console, in the left pane, click Output Profiles.
In the right pane, click the appropriate output method tab.
Select the output profile and then click Rename.

A OWON -

Type the new name of your output profile and press ENTER.

In the Output Profile dialog box, in the Name field, type a name for the new profile, and then click OK.

45



Activate an output profile

To activate an output profile that can be selected when printing, emailing, exporting, or faxing an item,
complete the following steps.

In Management Console, in the left pane, click Output Profiles.

In the right pane, click the output method tab, select the output profile, and click Modify.

On the General tab, select Is active.

Click OK.

A ODN -

Define email settings for an output profile

To define the settings to use when emailing an item, complete the following steps.

In Management Console, in the left pane, click Output Profiles.
2. Intheright pane, click the Email tab, select the output profile, and click Modify.
3. On the Output tab, for Email, perform one of the following actions.
« Type the email address where you want to send the output file.
« Leave the box empty to select the email address from the address book of your email client.
4. Inthe Method list, select a method for sending the email.
5. If you select Attachment, under Annotations, for Include, select one of the following options.
« Annotations to output the item with annotations.
« No annotations to output the item without annotations.
« Current view to output the current view of the item.
6. Click OK.

Define fax settings for an output profile

To define the fax number and cover page information to use when exporting an item to fax using an output
profile, complete the following steps.

1. InManagement Console, in the left pane, click Output Profiles.

2. Intheright pane, on the Fax tab, select the output profile you want to modify, and click Modify.

3. Inthe Output Profile dialog box, on the Output tab, under General, perform one of the following
options.

« If you have added fax numbers to your address book, select the number from the Fax Number list.

« If you are using a number that is not in your address book, enter the fax number to where you want
to send the item.

4. Under Cover Page, perform any of the following actions to add content to the fax cover page.
« Inthe Attention box, type the name of the recipient of the fax.
« Inthe Comments box, type any additional information you want to include with the fax.

5. Under Annotations, for Include, select one of the following options.
« Annotations to output the item with annotations.
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6.

« Current view to output the current view of the item.
« No annotations to output the item without annotations.
Click OK.

Define file settings for an output profile

To define the file format and location when exporting items to a file using an output profile, complete the
following steps.

A ON -

6.

In Management Console, in the left pane, click Output Profiles.
In the right pane, on the File tab, select the output profile you want to modify, and click Modify.
In the Output Profile dialog box, on the Output tab, for Format, select an output format.

To set the output directory, next to Location, click Browse and choose a location to store the output
files.

Note:

You must set a location. If you do not set one, the system prompts you with an error each time you try
to use the profile.

Under Annotations, for Include, select one of the following options.
« Annotations to output the item with annotations.

« Current view to output the current view of the item.

« No annotations to output the item without annotations.

Click OK.

Output file name variables

The following topic lists the variable text you can use when generating a custom file name to email an item as

an attachment or export an item to afile.

Note:

You can only use these variables with the multi-page TIFF and Individual file export formats. The Single PDF
file export does not support using these variables.

Guidelines

When entering variables, separate text with underscores and enclose variables with square brackets. The
entire file path, which includes the file name and extension, cannot exceed the character limit of your
operating system.
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Variables

Variable Description Example

[DOCID] The item ID Document_[DOCID]
[DRAWER] The item drawer value [DOCID]_Account_ [DRAWER]
[FIELD1] The item Field1 value [DOCID]_Account_[FIELD1]
[FIELD2] The item Field2 value [DOCID]_Patient_[FIELD2]
[FIELD3] The item Field3 value [DOCID]_Invoice_[FIELD3]
[FIELD4] The item Field4 value [DOCID]_Student_[FIELDA4]
[FIELD5] The item Field5 value [DOCID]_Program_[FIELD5]
[DOCTYPE] The item type [DOCTYPE]_[DOCID]

Manage views

About administering views

As a department manager, you create views that display only the content with which your users need to work.

By tailoring your user's view to only the items they need to see, you simplify their user experience. While the
system may contain hundreds or thousands of items and other types of content, your users see only the
subset of items that you enable in their view. Views enable you to add another layer of protection to content.
In addition to the access privileges set for drawers, file plans, and item types, your users can see the item
within a particular drawer, file plan, or type that satisfies the view definition.

You can also use a view to create a report if you have Business Insight installed in your environment.

To view records functionality, you must install a Records Manager license.

About administering related views

A user can display one or more related views from a viewer in Perceptive Content. When the user selects a
related view to apply to the active document or folder, the Related Documents or Related Folders pane
displays other items that match the items with respect to the conditions you define for the related view.

Users with document or folder view management privileges can create, rename, and delete related views in
Perceptive Content. When you modify a related view, you automatically enter Perceptive Content View
Designer, where you can create or modify relationship conditions, activate the view, and assign security
settings toit.



Suppose, for example, you view a student information document with a Field2 value that contains the
student's ID number. You want to see all the other documents with the same Field2 value. You can create the
condition for this relationship, and the Related Documents pane displays any other documents that have a
Field2 value that match the student ID number in the active document.

As another example, suppose you view an inventory document with a custom property that contains a check
number. Another set of business documents contains a check number in Field3 rather than in a custom
property. You want to see all documents with a Field3 value that matches the Check Number custom property
in the active document. You can create the conditions for this relationship, and the Related Documents pane
displays any other documents that have a Field3 value that matches the Check Number custom property in
the active document.

For folders, related views are like related views for documents except that the relationship matches on folder
properties. For example, suppose you work at a hospital and your Perceptive Content environment is set up
so that each time a patient visits the hospital, a new folder is created. The new folder contains all documents
related to that visit. If a patient makes a return visit, that patient will have two folders created, one for each
visit. You view a recent patient's visit and realize you need to see all other folders from past visits. You can
create the conditions for this relationship, view all folders that correspond to the patient's identification code,
and open any folders that you need to view.

Types of views

The following list summarizes views available in Perceptive Content, including views created by you, your
view manager, and views created automatically by the Perceptive Content system.

Application Plan

An application plan view returns a set of documents captured using a specific application plan. Application
plans that do not have a defined view action do not display results.

Modifiable components
View conditions
Column layout
View statistics

Sorting and grouping

Security considerations

Users with application plan management privileges can modify application plan views, including view
actions and components, in Application Plan Designer.

Users with the View privilege for the application plan can run the view. For the active business
application plan screen, the view returns the associated results.
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Batches

A batch view retumns the batches in your Perceptive Content system. By default, batch users can see all
batches, batches that are ready for QA, and batches that are ready for linking.

Modifiable components
Column layout

Sorting and grouping

Document

A document view returns a set of documents. Document views appear in the Views pane under Documents.
Modifiable conditions

View name

View privileges

View conditions

Public filters

Private filters

Column layout

View statistics

Sorting and grouping

Security considerations

Users with view access can run a document view.

File Plans

A file plan view returns a set of records within a particular record category or record folder. File plan views
appear in the Views pane under File Plans, and are organized according to the hierarchy of file plans, record
categories, and record folders in the system. When you select one of these items, Perceptive Content
retrieves the set of records within that item.

ImageNowEXxplorer uses the system-defined view and it cannot be modified. You can modify a view during a
viewing session, but you can t create and save filters or views for file plan view.

File plan view does not use Quick Search, only Advanced Search.
Modifiable components
View conditions

Column layout

50



Sorting and grouping
Security considerations

Inthe views tree, users see only the file plans for which they have been granted Search privileges, and
the record categories and record folders for which they have been granted Use privileges.

Folder

A folder view returns a set of folders. Folder views appear in the Views pane under Folders.
Modifiable conditions

View name

View privileges

View conditions

Public filters

Private filters

Column layout

View statistics

Sorting and grouping

Security considerations

Users with view access can run a folder view.

Folder content

When the user opens a folder, Folder Viewer displays a secondary grid that lists the folder's contents. This
secondary grid is called a folder content view. Because document and folder shortcuts can belong to any
number of folders, the same document or folder might appear as a representation in Folder Viewer with
different grid layouts, depending on the type of folder the user opens.

Changes you make apply to all folders associated with the modified folder type. Because you can represent a
document or folder using shortcuts in any number of folders, the same item might appear in a folder content
view with different grid layouts, depending on the folder's type.

Modifiable conditions
Column layout
View statistics

Sorting and grouping

Security considerations
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Users with folder type management privileges can modify components of the folder content view in
Management Console.

Recently received documents

Recently received documents appear in a temporary view that appears when one Perceptive Content user
transfers documents to another user with the Send to User feature. This transfer must occur while both users
are connected to the same ImageNow Server. The view sorts the received documents according to the name
of the sending user and the time they were sent.

Record

To view records functionality, you must install a Records Manager license.

A record view retumns a set of records. Record views appear in ImageNowEXxplorer, in the Views pane under
Records.

Modifiable conditions
View name
View privileges
View conditions
Public filters
Private filters
Column layout
View statistics

Sorting and grouping

Security considerations

Users with view access can run a record view.

Record Folder

A record folder view returns a set of record folders and record categories. Record Folders views appear in
ImageNowEXxplorer, in the Views pane under Record Folders.

Modifiable conditions
View name
View privileges
View conditions
Public filters

Private filters
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Column layout
View statistics

Sorting and grouping

Security considerations

Users with view access can run a record folder view.

Record Folder Content

When the user opens a record folder, Record Folder Viewer displays a secondary grid that lists the folder s
contents. This secondary grid is called a record folder content view. Because record folder shortcuts can
belong to any number of record folders, the same record folder might appear as a representation in Record
Folder Viewer with different grid layouts, depending on the type of record folder the user opens. Changes you
make apply to all record folders associated with the modified record folder type.

Modifiable conditions
Column layout
View statistics

Sorting and grouping

Security considerations

Users with record folder management privileges can modify components of the record folder content
view in Management Console.

Recycled documents and document folders

When the user deletes a document or folder, Perceptive Content moves the item to a system view called My
Recycled Documents or My Recycled Folders.

Items remain in the recycled view for the number of days that you specify in the inserverFS.inifile.
Modifiable conditions

Private filters

Security considerations

If the user is a Department Manager, two additional views appear. These views, All Recycled
Documents and All Recycled Folders, display all items deleted by all users. As long as the user can see
arecycled document or folder, the user can restore it to its previous state, at which time the document or
folder keeps the attributes it had before deletion, if possible.
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Related

Related views appear in the Related Documents pane of the document viewer and in the Related Folders
pane of the folder viewer. A related view applies the relationship selected in the list to the current document or
folder. The view displays a list of all documents or folders that satisfy the conditions of the relationship.

Modifiable conditions
Relationship name
View privileges
View conditions
Public filters
Private filters
Column layout
View statistics
Sorting and grouping

Security considerations

Users with document view management privileges can create and modify document relationships in
Management Console. Users with folder view management privileges can create and modify folder
relationships in Management Console.

Task

A task view returns a list of tasks assigned to the user according to the type of task, such as My Assigned or
To Review. Task views appear in the Views pane under Tasks.

Modifiable conditions
Public filters
Private filters
View statistics
Column layout

Sorting and grouping

Workflow process

A workflow process view returns a list of items (representing documents or folders) when the user accesses a
workflow process, which appears in the Views pane under Workflow.

Modifiable conditions

Private filters
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Security considerations

Workflow process views appear automatically depending on the workflow queues for which a user has
the necessary privileges. Users with workflow process management privileges can modify workflow

queue view components in Workflow Designer.

Security considerations

Users with view access can run a folder view.

Workflow queue

A workflow queue view returns a list of items (representing documents or folders) when the user accesses a

workflow queue, which appears in the Views pane under Workflow.

Modifiable conditions
Column layout
View statistics
Private filters

Grouping and sorting

Security considerations

Workflow queue views appear automatically depending on the workflow queues for which a user has the
necessary privileges. Users with workflow process management privileges can modify workflow queue
view components in Workflow Designer.

Supported file formats for Perceptive Content

The following tables list the file formats that ImageNowViewer support.

Archive file formats

Format Version Extension
7-Zip 4.57 7Z

BinHex N/A HQX

GzIP 2 Gz

Java Archive N/A JAR
Microsoft Cabinet Format 1.3 CAB




Format Version Extension

Microsoft Compressed Folder N/A LZH, LHA

PKZIP Through 9.0 ZIP

RAR Archive 2.0 through 3.5 RAR

Tape Archive N/A TAR

Unix Compress N/A Z

UUEncoding All versions UUE

WinZip Through 10 ZIP
Binary file formats

Format Version Extension

Executable N/A EXE

Link Library N/A DLL
Database file formats

Format Version Extension

Microsoft Access 95, 97, 2000, 2002, 2003 MDB
Display file formats

Format Version Extension

Adobe PDF Through 9 PDF




Graphic file formats

Format Version Extension
Computer Graphics Metafile N/A CGM
CorelDRAW Through 9.0 CDR
DCX Fax System N/A DCX
Digital Imaging and N/A DCM
Communications in Medicine

Encapsulated PostScript (raster) TIFF header EPS
Enhanced Metafile N/A EMF

GIF 87, 89 GIF
JPEG N/A JPEG, JPG
Lotus AMIDraw Graphics N/A SDW
Lotus Pic N/A PIC
Macintosh Raster 2 PIC, PCT
MacPaint N/A PNTG
Microsoft Office Drawing N/A MSO

PC PaintBrush 3 PCX
Portable Network Graphics N/A PNG

Sun Raster Image N/A RS
Tagged Image File Through 6.0.3 TIFF
Truevision Targa 2 TGA
Windows Animated Cursor N/A ANI




Format Version Extension
Windows Bitmap N/A BMP
Windows Icon Cursor N/A ICO
Windows Metafile 3 WMF
WordPerfect Graphics 1 1 WPG
WordPerfect Graphics 2 2,7 WPG

Mail file formats

Format Version Extension
Lotus Notes database 4,5,6.0,6.5 NSF
Microsoft Outlook 97, 2000, 2002, 2003 MSG
Microsoft Outlook Personal 97, 2000, 2002, 2003 PST
Folder

Multimedia file formats

Any audio or movie format supported by Apple QuickTime or Windows Media Player. For specific formats
supported by these players, refer to the respective Apple or Microsoft websites. Depending on your hardware
and network, large movie files (over 100 MB) may slow performance.

Presentation file formats

Format Version Extension
Applix Presents 4.0,4.2,4.3,44 AG

Corel Presentations 6,7,8,9, 10, 11,12, X3 SHW

Lotus Freelance Graphics 2 2 PRE

Lotus Freelance Graphics 96, 97, 98, R9, 9.8 PRZ

Microsoft PowerPoint Macintosh 98, 2001, 2004 PPT, PPS, POT




Format

Version

Extension

Microsoft PowerPoint PC

4

PPT, PPS, POT, PPTX, PPTM,
POTX, POTM, PPSX, PPSM

Microsoft PowerPoint Windows

95, 97, 2000, 2002, 2003, 2007

PPT, PPTM, PPTX

Spreadsheet file formats

Format Version Extension
Applix Spreadsheets 42,4.3,44 AS
Comma Separated Values N/A Ccsv

Corel Quattro Pro 56,7,8 WB2, WB3
Lotus 1-2-3 96, 97, R9, 9.8 123

Lotus 1-2-3 2,3,4,5 WK4
Lotus 1-2-3 Charts 2,3,4,5 123
Microsoft Excel Charts 2,3,4,56,7 XLS

Microsoft Excel Windows

2.2 through 2007

XLS, XLSM, XLSX, XLW, XLT,
XLA, XLTX, XLTM, XLAM

Microsoft Excel Macintosh 98, 2001, v.X, 2004 XLS

Microsoft Works Spreadsheet 1,2,3,4 S30, S40
OASIS Open Document Format 1,2 ODS, SXC, STC
OpenOffice Calc 1,1.1 SXC, ODS, OTS
StarOffice Calc 6,7 SXC, ODS




Text and Markup file formats

Format Version Extension
ANSI N/A TXT
ASCII N/A TXT
HTML 3,4 HTM
Microsoft Excel Windows XML 2003 XML
Microsoft Word Windows XML 2003 XML
Rich Text Format 1 through 1.7 RTF
Unicode Text 3,4 TXT

Note: Specific support is only

applicable to the Unicode

version.
UTF-8 N/A TXT
UTF-8 - No Byte Order Mark N/A TXT
(BOM)
UTF-16 Little Endian (UTF-16LE) | N/A TXT

Note: A BOM is required for the

UTF-16LE format to be read

correctly.
XHTML 1 HTM, XHTML
XML 1.0 XML

Word processing file formats

Format Version Extension
Adobe FrameMaker Interchange 555,6,7 MIF




Format Version Extension
Format

Applix Words 3.11,4,4.1,4.2,43,4.4 AW

Corel WordPerfect Linux 6.0, 8.1 WPS
Corel WordPerfect Macintosh 1.02,2,2.1,2.2,3, 3.1 WPS
Corel WordPerfect Windows 5,5.1 WO, WPS
Corel WordPerfect Windows 6,7,8,9, 10, 11,12, X3 WPD
DisplayWrite 4 IP

Folio Flat File 3.1 FFF
Fujitsu Oasys 7 OA2

IBM DCA/RFT (Revisable Form SC23-0758 -1 DC

Text)

JustSystems Ichitaro 8 through 2005 JTD

Lotus AMI Pro 2,3 SAM
Lotus AMI Professional Write 21 AMI

Plus

Lotus Word Pro 96, 97, R9 LWP
Lotus SmartMaster 96, 97 MWP
Microsoft Word PC 4,5,5.5,6 DOC

Microsoft Word Windows

1.0, 2.0, 6, 7, 8, 95, 97, 2000,

DOC, DOCX, DOCM, DOT,

2002, 2003, 2007 DOTX, DOTM
Microsoft Word Macintosh 4,5, 6, 98, 2001, v.X, 2004 DOC, DOT
Microsoft Works 1,2, 3, 4,6, 2000 WPS
Microsoft Windows Write 1,2,3 WRI




Format Version Extension
OASIS Open Document Format 1,2 ODT, SXW, STW
Wordpad Through 2003 RTF
XyWrite 412 XY4

Work with Views

Create a view

To create a new view, complete the following steps.

1. InManagement Console, in the left pane, click Views.
2. Intheright pane, click the appropriate tab, and then click New.
3. Inthe New View dialog box, define a name and description for this view and click OK.

Next Modify the view in View DesignerManagement Console to define conditions, column layout, filters, and
view security.

Create arelated view

To create a relationship view for an item, perform the following steps.

1. InManagement Console, in the left pane, click Relationships.
2. Intheright pane, on the Related tab, click New.

3. Inthe New Relationship dialog box, type a name and an optional description of the view that appears
in the Tool Tip for the view, and then click OK.

Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Copy a view

You can copy a view to create a new view with the same conditions, filters, column layout, and security
settings. To copy a view, perform the following steps.

You cannot copy a task view.

In Management Console, in the left pane, click Views.
2. Onthe appropriate tab, select the view definition and click Copy.
To view records functionality, you must install a Records Manager license.
3. Inthe Copy View dialog box, type a name and optional description for the new view.

4. Optional. To copy public filters associated with the original view definition, select the All public
filters check box.

5. Optional. To copy users and the view privileges associated with the original view definition, select the
All users and their privileges check box.



6. Optional. If you included users and you also want to copy any private filters created by those users,
select the Private filter for users check box.

7. Click OK.
Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Copy arelated view

To copy a relationship view for an item, complete the following steps.

1. InManagement Console, in the left pane, click Relationships.

2. Intheright pane, click the Related tab.

3. Select the relationship and click Copy.

Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Delete a view

To delete a view, perform the following steps.

In Management Console, in the left pane, click Views.

2. Onthe Document, Folder, Record, or Record Folder tab, select the view and click Delete.
To view records functionality, you must install a Records Manager license.

3. Inthe confirmation dialog, click Yes.

Result Users will not see the view removed until they log out and log in again.

Delete a related view

To delete a relationship view for a document, complete the following steps.

1. InManagement Console, in the left pane, click Relationships.
2. Intheright pane, click the Related tab.

3. Select the relationship and click Delete.

4. Inthe confirmation dialog box, click Yes.

Rename a view

To rename a view, complete the following steps.
You can also rename a view by editing its properties in View Designer. You cannot rename a task view.

In Management Console, in the left pane, click Views.

In the right pane, on the appropriate tab, select the view you want to rename and click Rename.
In the Rename View dialog box, type the new view name and an optional description.

Click OK.

A WODN -
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Rename arelated view

To rename a relationship view for documents or folders, complete the following steps.

1. InManagement Console, in the left pane, click Relationships.

2. Intheright pane, click the Related Documents or Related Folders tab.

3. Select the relationship and click Rename.

4. Inthe Rename Relationship dialog box, type the new name of the relationship in the Name box.
Modify a view

To modify components of a view, complete the following steps.

Prerequisite It is recommended that you perform view modifications when no users are signed in to
Perceptive Content.

1. InManagement Console, in the left pane, click Views.
2. Intheright pane, on the appropriate tab, select the view you want to change and click Modify.
Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Modify a related view

To modify a relationship view for an item, complete the following steps.

Prerequisite It is recommended that you perform view modifications when no users are signed in to
Perceptive Content.

1. InManagement Console, in the left pane, click Relationships.

2. Intheright pane, click the Related tab.

3. Select the relationship and click Modify.

Next Modify the view in View Designer to define conditions, column layout, filters, and view security.

Version control status indicators

Any document added to version control, either in its current version or in a previous version, is accompanied
by a status indicator in the document search results grid, in the Version Controlled column. If your view does
not show this column, you can temporarily display it or you can add the column in a private filter.

None

The document is not version controlled.

Checked In

The document is version controlled but not currently checked out to any users.



Checked Out

This document is version controlled and currently checked out by another user.
Checked Out by You

!

ol

This document is version controlled and currently checked out by you.

If a document is checked in, but marked private by another user, the Is Private icon . appears inthe Is
Private column in the document search results grid.

Configure recycle bin views

You can determine the amount of time an item appears in the recycle bin views in ImageNowExplorer before
permanently deleting it. To configure recycle bin views, complete the following steps.

The following recycle bin views are available to configure: My Recycled Documents, My Recycled Folders,
All Recycled Documents, and All Recycled Folders.
Open the [drive:]\inserver\etc\inserverFS.ini file with a text editor.

2. Todetermine the number of days you want items to remain in the recycled views before they are
permanently removed from ImageNow Server, under [General], perform one of the following actions
for the destruction.wait.time setting.

« Toimmediately delete items from the recycle bin, enter 0.
« Todelete items from the recycle bin after a specific number of days, enter the number of days.

Note: You cannot enter a negative integer. The maximum number of days you can retain items in a
recycle bin view is 2,147,483,647.

3. Save and close the inserverFS.ini file.
4. Restart the File System Agent service.

Set the system default view

You can set the system-wide default view to use a link that does not specify which view to use, and the user
does not have a default view configured. To set the system default view, complete the following steps. You
must be a department manager to set the default system view.

You can also set the default view on a per-user basis in Management Console.

1. InManagement Console, in the left pane, under Select Department, select a department from the
list.
2. Intheleft pane, select Views.

3. Intheright pane, select the System Defaults tab.
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4. Inthe Document view list, select a default document view.
5. Inthe confirmation prompt, click Yes.

Note: Select None from the list to remove the default document view.

6. Inthe Folder view list, select a default folder view.
7. Inthe confirmation prompt, click Yes.

Note: Select None from the list to remove the default folder view.

Folder content search conditions

When you display the Search pane on the Content tab of Folder Viewer, several conditions are available. The
Add Condition dialog box allows you to build a search using a combination of constraints, fields, operators,
and values described in the following table.

If you are performing a variable search, you can select one of the following values to use as a variable for the
current user: user name, first name, last name, title, organization, organization unit, locality, or user ID. You
can also use the current date and time as a variable.

Composite property

The Composite property constraint allows the following operators: is equal to, is not equal to, is less
than, is greater than, is less than or equal to, is greater than or equal to, starts with, does not start with,
ends with, does not end with, contains, does not contain, is blank, is not blank is one of, is not one of, is
between, and is not between.

The composite properties, which can contain all possible values, are defined by your administrator.

You can select a composite property is the Composite list, or you can select a custom property in the
Field list.

Custom property

The Custom property constraint allows the following operators: is equal to, is not equal to, is less than,
is greater than or equal to, starts with, does not start with, ends with, does not end with, contains, does
not contain, is blank, is not blank, is one of, is not one of, is between, is not between, is equal to, is not

equal to
Constraint Operators Field Field Possible Values
Description

Composite is equal to, is not In the Composite Composite All defined
property equal to, isless list, select a properties are composite

than, is greater composite defined by your properties

than, is less than property. In the administrator.

Field list, select a




Constraint

Operators

Field

Field
Description

Possible Values

orequal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

custom property.

Content property

is equal to, is not
equal to, isless
than, is greater
than, is less than
or equal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

Content type

The type of
content in the
folder.

« Document

« Document
Shortcut
Folder

« Folder
Shortcut

Added to folder
within (days)

The number of
days within which
the document,
folder, or shortcut
was added or
moved to the
folder.

Type any positive
integer.

Created within
(days)

The number of
days within which
the document,
folder, shortcut

Type any positive
integer.




Constraint Operators Field Field Possible Values
Description
was created.

Name The name value of | Type any
the document, alphanumeric
folder, or shortcut. | value.

Drawer The drawer value Type any
associated with alphanumeric
the document, value.
folder, oritem
referenced by a
shortcut.

Document ID The unique ID of Type any
the document. alphanumeric

value.

Field1 The Field1 value Type any
associated with alphanumeric
the document or value.
document
referenced by a
shortcut.

Field2 The Field2 value Type any
associated with alphanumeric
the document or value.
document
referenced by a
shortcut.

Field3 The Field3 value Type any
associated with alphanumeric
the document or value.
document
referenced by a
shortcut.

Field4 The Field4 Type any

associated with
the document or
document
referenced by a

alphanumeric
value.




Constraint Operators Field Field Possible Values
Description
shortcut.
Field5 The Field5 Type any

associated with
the document or
document
referenced by a
shortcut.

alphanumeric
value.

Document type

The document
type associated
with the document

Type any
alphanumeric
value.

or document
referenced by a
shortcut.
Folder ID The unique ID of Type any
the folder. alphanumeric
value.
Folder type The folder type Type any

associated with
the folder or folder
referenced by a
shortcut.

alphanumeric
value.

Custom property

is equal to, is not
equal to, isless
than, is greater
than, is less than
or equal to, is
greater than or
equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

Select a custom
property.

Custom properties
are defined by
your administrator.

All defined custom
properties




Constraint

Operators

Field

Field
Description

Possible Values

Date

is equal to, is not
equal to, isless
than, is greater
than, is less than
orequal to, is
greater than or
equal to, is one of,
is not one of, is
between, is not
between

Added to folder

The date the
content was added
or moved to the
folder.

Type or select a
date value.

Checked out

The date the
document or
document
referenced by a
shortcut was
checked out in
version control.

Type or select a
date value.

Created

The date the
document, folder,
or shortcut was
created.

Type or select a
date value.

Last viewed

The date the
content was last
viewed by a user.

Type or select a
date value.

Modified

The date the
document, folder,
or shortcut was
last modified.

Type or select a
date value.

Status changed

The date the
folder's active or
inactive status
changed.

Type or select a
date value.

Document Status

is equal to, is not
equal to

Digital signature
status

The status of the
version controlled
digital signature of
the document.

Valid, Invalid,
Void, Not Signed




Constraint

Operators

Field

Field
Description

Possible Values

Has hold applied

Whether the
document has a
direct or inherited
retention hold
applied.

Yes, No

Has physical
reference

Whether the
document had a
physical file
reference.

Yes, No

Is private

Whether the
document is
marked private in
version control.

Yes, No

Is version
controlled

Whether the
document is
added to version
control.

Yes, No

Folder Status

is equal to, is not
equal to

Folder status

The active or
inactive status of
the folder.

Active, Inactive

Has required
documents

Whether the folder
has required
document types.

Yes, No

Physical property

is equal to

is not equal to, is
less than, is
greater than, is
less than or equal
to, is greater than
or equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is

In the Template
list, select a
physical file
template. In the
Field list, select a
physical property.

Physical file
templates and
physical properties
are defined by
your administrator.

Template: All
physical file
templates the user
can access, Field:
All physical
properties
associated with
the template




Constraint

Operators

Field

Field
Description

Possible Values

not one of, is
between, is not
between

User

is equal to, is not
equal to, starts
with, does not
start with, ends
with, is blank, is
not blank, is one
of, is not one of

Checked out by

The user who has
the document
checked out in
version control.

Type an
alphanumeric
value. Any valid
user name.

Created by

The user who
created the
document, folder,
or shortcut.

Last viewed by

The user who last
viewed the
document, folder,
or item referenced
by a shortcut.

Modified by

The user who last
modified the
document, folder,
or shortcut.

Private by

The user who
marked the
document private
in version control.

Status changed by

The user who last
changed the folder
status.

Workflow item
property

is equal to, is not
equal to, isless
than, is greater
than, is less than
orequal to, is
greater than or

Is in workflow

Whether the
document or folder
is added to
workflow.

Yes, No




Constraint

Operators

Field

Field
Description

Possible Values

equal to, starts
with, does not
start with, ends
with, does not end
with, contains,
does not contain,
is blank, is not
blank, is one of, is
not one of, is
between, is not
between

Workflow queue

The workflow
queue associated
with the
document, folder,
or item referenced
by a shortcut.

Type an
alphanumeric
value.

Workflow item
user

The user who
added the
document, folder,

Type an
alphanumeric
value. Any valid

status

document, folder,
or item referenced
by a shortcut in
workflow.

or item referenced user name.
by a shortcut to
workflow.
Workflow item The status of the Idle, Working, On

hold, Pending,
Waiting for
routing, Waiting
for inbound action

Sort view or search results

You can sort the rows in the results grid for a view or public filter. To sort view results, complete the following

steps.

1. Inthe view preview or search results grid, to sort by a single column, right-click the column heading and
then do one of the following:

« Tosort the results in ascending order, select Sort Ascending.

« Tosort the results in descending order, select Sort Descending.

2. Tosort by additional columns, hold the SHIFT key and click the column heading once to sort the results
in ascending order or twice to sort the results in descending order.




Note: To sort on multiple columns, you must group the results.

3. Optional. Toremove all sorting, right-click a column heading and select Reset sort order.
4. Save the view or filter to preserve the sort order.

Select columns to display

To show or hide columns in a view or public filter, complete the following steps.

1. InView Designer, in the Preview pane, click the Columns button.
2. Inthe Columns dialog box, do the following substeps:

1. Forthe column or columns you want to hide, clear the check box. To hide all columns, right-click
anywhere in the dialog box and then click Clear All.

2. Forthe column or columns you want to show, select the check box. To show all columns, right-
click anywhere inside the dialog box and then click Select All.

3. Click OK.
3. Inthe Designer toolbar, click the Save button.

Group view or search results

You can group the results of a view, filter, or search by one or more columns into groups you can expand and
collapse. To group view results, complete the following steps.

1. Inthe search results grid or view preview grid, right-click a column heading, and then click Group by
this Column.
Groups are initially collapsed when the view or filter runs.

2. Optional. To create a subgroup under the grouped column, right-click a column heading, and then click
Group by this Column.

3. Optional. To expand the grouped results, right-click a column headings, and then click Expand All
Groups.

4. Save the view orfilter to preserve the column grouping.

About viewing batches by batch user

A user can view batches captured by batch users, and can be limited to viewing batches captured only by
specific batch users.

Users can capture batches with the Global > Capture > Batch Mode privilege and then view those batches.

If you want a user to view batches captured by any other batch users, you must give the user the Drawer >
Batch (Proposed Key) > Process privilege for each drawer.

If you want to limit a user to viewing batches captured only by specific batch users, you must also enable
filtering by batch user. When you enabile filtering by batch user, you create a list of only those batch users
whose batches you want the user to view.
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Add a custom property column

To add columns to display custom property values for content, complete the following steps.

1. Access the view using one of the following methods:

Situation Steps
Add a custom property column for a workflow 1. Open the workflow process in Workflow
queue view Designer.
2. InWorkflow Designer, open the desired
queue.
3. Inthe Queue Properties dialog box, click
Appearance.

4. Inthe right pane, click Preview.

Add a custom property column for a view 1. Open the view in View Designer.
2. InView Designer, click View > Preview.

Add a custom property column for a folder 1. In Management Console, in the left pane,

content view click Folder Types.

2. Intheright pane, on the Folder Types tab,
select the folder type and click Modify.

3. Inthe Folder Type dialog box, on the
Appearance tab, click Preview.

2. Inthe View Preview window, click the Columns button.
3. Inthe Columns dialog box, click Add.
4. Inthe Custom Property dialog box, select the Filter by list and do one of the following actions:
« Todisplay a custom property based on item type, select Document Types.
« Todisplay a custom property based on folder type, select Folder Types.
« Todisplay all custom properties, select All Custom Properties.
5. Inthe Type list, select a custom property.
The Type list options change based on the Filter by option selected.
6. Select a custom property and click Add.
7. Click OK.

Enable filtering by batch user for a group

A group can view batches captured by batch users if granted the appropriate drawer privileges for the drawers
for which the batches are targeted. To further limit groups to viewing only batches captured by specific batch
users, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select Cross Department
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Settings from the list.

In the left pane, click Groups.

In the right pane, select the group you want and click Modify.

In the Modify Group Profile dialog box, in the left pane, click Batch Users.
Select Enable filtering by batch user.

ok wN

To add batch users to the list, complete the following substeps.

1. Click Add.

2. Inthe Select Users dialog box, under Available Users, select a user and click Add.
3. Click OK when you finish adding batch users.

7. Optional. To remove batch users from the list, complete the following substeps.

1. Click the batch user.

2. Click Remove.

Enabile filtering by batch user for a user

A user can view batches captured by batch users if granted the appropriate drawer privileges for the drawers
for which the batches are targeted. To further limit users to viewing only batches captured by specific batch
users, complete the following steps.

1. InManagement Console, in the left pane, under Select Department, select Cross Department
Settings from the list.

In the left pane, click Users.

In the right pane, select the user you want and click Modify.

In the Modify User Profile dialog box, in the left pane, click Batch Users.

Select Enable filtering by batch user.

ok wNbN

To add batch users to the list, complete the following substeps.

1. Click Add.

2. Inthe Select Users dialog box, under Search, select a user and click Add.
3. Click OK when you finish adding batch users.

7. Optional. To remove batch users from the list, complete the following substeps.
1. Click the batch user.

2. Click Remove.

Add a custom property column for records

To add a custom property column for a record content view, complete the following steps.
1. InManagement Console, in the left pane, click Records and select Record Folder Types or Record
Category Types.

2. Intheright pane, on the Record Folder Types or Record Category Types tab, select the folder type
and click Modify.

3. Inthedialog box, on the Appearance tab, click Preview.
4. Inthe View Preview window, click the Columns button.
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5. Inthe Columns dialog box, click Add.
6. Inthe Custom Property dialog box, select the Filter by list and do one of the following actions:
« Todisplay a custom property based on record type, select Record Types.
« Todisplay a custom property based on record folder type, select Record Folder Types.
« Todisplay all custom properties, select All Custom Properties.
7. Inthe Type list, select a record or record folder type.
The Type list options change based on the Filter by option selected.
8. Select a custom property and click Add.
9. Click OK.

Statistics

What are statistics?

Statistics are calculations such as the maximum, minimum, and average of all the values in a specific column
that appear in the search results for the view.

You can define statistics for any document view, folder view, task view, record view, or record folder view for
which you have management privileges. You cannot define statistics for a public filter or a related view.

For any folder type for which you have management privileges, you can create a view that determines the
appearance of the folder content results in Folder Viewer. You can also create a statistic for a workflow view,
which defines the appearance when viewing the contents of a workflow queue. When you define a set of
statistics for a folder content or workflow view, the statistics appear in a pane below the search results grid. In
the statistics pane, you can view the statistics, highlight the search results in the grid that apply to the
statistic, and, if only one document or folder matches the statistic value, open the document or folder.

The following examples demonstrate some ways you can use view statistics.

Accounts Payable: Theresa is an Accounts Payable administrator who wants to quickly view the total
of all the invoices in her "Openlnvoices" view. This view contains a custom property column which
stores the invoice amount for each document. Because it is a numeric custom property, Theresa adds
a Sum statistic on this custom property column named "Total open amount". Every time she runs a
search using this view, she sees the total invoice amount of all the documents returned by the search
in the statistics pane.

Admissions: Sam is an Admissions director who wants to view the average ACT score of the students
who applied to his university in the current academic year. His student folder view contains a custom
property column which stores the ACT score for each student and a date range that spans the current
academic year. Because the view uses a numeric custom property, Sam adds an Average statistic on
this custom property column named "Average ACT."

Healthcare: Dr. Lovelace wants to quickly view the next task he is responsible for in his folder view
that lists all his patients with document deficiencies. His view administrator adds a Next statistic to
the task due date column in the view. When Dr. Lovelace logs in, he can quickly see the date the next
task is due, highlight the document associated with the task, and open it in ImageNowViewer.



To view records functionality, you must install a Records Manager license.

Data types for statistical functions

The statistical functions you can define depend on the data type of the column values. To add a statistic for a
custom property column, you must first add the custom property column to the view. The following statistics
are available for the specified data types.

Statistical functions

Average
This function calculates the average of the column values.

Column value data type

Numeric

Sample columns
Summary Task Count

<Number custom property>

Count

This function counts the number of values in the search results grid that match the selected variable
(you must select a variable for this statistical function).

Column value data type

String, list, flag

Sample columns
Folder Name
In Workflow
<List custom property>
<String custom property>

<Flag custom property>

Count Future
This function counts the number of the column’s date values that occur in the future.

Column value data type

Date
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Sample columns
Next Task Due
Due Date

<Date custom property>

Count Past
This function counts the number of the column's date values that occur in the past.

Column value data type

Date

Sample columns
Created
Last Viewed

<Date custom property>

First

This function distinguishes the earliest date in the column's search results.
Column value data type

Date

Sample columns
Modified
Checked Out

<Date custom property>

Last

This function distinguishes the latest date in the column's search results.
Column value data type

Date



Sample columns
Checked In
Assigned

<Date custom property>

Maximum
This function distinguishes the largest numeric value in the column's search results.

Column value data type

Numeric

Sample columns
Pages

<Number custom property>

Median
The function distinguishes the middle value in the column's search results.

Column value data type

Sample columns
Current Version

<Number custom property>

Minimum
This function distinguishes the smallest numeric value in the column's search results.

Column value data type

Numeric

Sample columns
Days Until Due

<Number custom property>

Mode

This function distinguishes the most frequently occurring numeric value in the column's search
results.



Column value data type

Numeric

Sample columns
Summary Task Count

<Number custom property>

Next

This function distinguishes the next sequential date value in the column's search results.
Column value data type

Date

Sample columns
Status Changed

<Date custom property>

Previous
This function distinguishes the previous sequential date value in the column's search results.

Column value data type

Date

Sample columns
Completed

<Date custom property>

Sum
This function calculates the total of the values in the column's search results.

Column value data type

Numeric
Sample columns
Pages

<Number custom property>



Add view statistics overview

The configuration of a view statistic differs based on the data value type you select. You can create statistics
for document, folder, folder content, record, task, and workflow views. To create a statistic for a view,
complete any of the following procedures.

« Add a statistic for a date value.

« Add a statistic for a flag value.

» Add a statistic for a list value.

« Add a statistic for a numeric value.

o Add a statistic for a string value.

Add a statistic for a date value

You can display the newest, oldest, or next date value in a list of search results, or display the total number of
dates in the past or dates in the future. To add a statistic for a date value, complete the following steps.

Prerequisite Before you can add a statistic for a date custom property value, you must first add the custom
property column to the view.

2. Inthe Preview pane, click the Statistics button.
3. Inthe Statistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to view the next task due date, type Next task due.

5. Under Column, select the view column with the date values.
6. Under Function, select one of the following options depending on the display variable you want to

show:
Situation Steps
Total number of dates in the future « Select Count Future.
Total number of dates in the past o Select Count past.
Oldest date value « Select First.
Newest date value o Select Last.
The next future date « Select Next.
The most recent date « Select Previous.

7. Optional. Under Caption, select the value to display when the statistic only applies to one search



result.

Example If a Previous statistic shows the last viewed item, and you want to quickly display the user
name of the user who viewed the item, you can use the Caption column to select the Last Viewed By
user.

8. Optional. To reorder the statistic, click the Move Up or Move Down button until the statistic reaches
the desired position.
9. Click OK.
The statistic appears below the grid in the Preview pane.
10. Inthe Preview pane, click the Run button to test the statistic's performance.

Add a statistic for a flag value

You can add a statistic that distinguishes the number of search results that have a true or false (boolean)
value. To add a statistic for a flag value, complete the following steps.

Prerequisite Before you can add a statistic for a flag custom property value, you must add the flag custom
property column to the view.

2. Inthe Preview pane, click the Statistics button.

3. Inthe Statistics dialog box, click Add.

4. Under Label, type a label that describes the statistical function to appear in the search results grid.
Example If adding a statistic to count the number of documents or records assigned to a retention
policy, type Documents in RetentionoOrRecords in Retention.

5. Under Column, select the view column with the flag values.

6. Under Function, select Count.

7. Under Variable, select whether you want to count the results that meet the TRUE condition or the
FALSE condition.

8. Optional. Under Caption, select the value to display when the statistic applies to only one search
result.

Example If there is one version-controlled item in your search results, and you want to quickly display
the user who marked the item private, you can use the Caption column to select the Private By user.

9. Optional. To reorder the statistic, click the Move Up or Move Down button until the statistic reaches
the desired position.
10. Click OK.
The statistic appears below the grid in the Preview pane.
11. Inthe Preview pane, click the Run button to test the statistic's performance.



Add a statistic for a list value

You can add a Count statistic that distinguishes a unique value of a list custom property. To add a statistic for
alist value, complete the following steps.

Prerequisite Before you can add a statistic for a list value, you must first add the list custom property
column to the view.

2. Inthe Preview pane, click the Statistics button.

3. Inthe Statistics dialog box, click Add.

4. Under Label, type a label that describes the statistical function to appear in the search results grid.
Example If you have a list custom property to select the fiscal quarter associated with an invoice and
you want to add a statistic to show fourth quarter invoices, type Invoices in Q4.

5. Under Column, select the list custom property.

6. Under Function, select Count.

Note: Countis the only statistical function for list values.

7. Inthe Variable list, select an item from the list to use for the statistic.
8. Optional. Under Caption, select the value to display when the statistic applies to only one search
result.

Example If there is only one item added to workflow during the month of January, and you want to
quickly display the user who added the item to workflow, you can use the Caption column to select the
workflow user.

9. Optional. To reorder the statistic, click the Move Up or Move Down button until the statistic reaches
the desired position.
10. Click OK.
The statistic appears below the grid in the Preview pane.
11. Inthe Preview pane, click the Run button to test the statistic's performance.

Add a statistic for a numeric value

You can display the average, sum, median, or mode statistic that distinguishes numeric values, such as the
number of tasks or a custom property that stores an amount value. To add a statistic for a numeric value,
perform the following steps.

Prerequisite Before you can add a statistic for a flag custom property value, you must add the flag custom
property column to the view.

2. Inthe Preview pane, click the Statistics button.
3. Inthe Statistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.



Example If adding a statistic to view the average amount of invoices, type Average invoice
amount.

5. Under Column, select the view column with the flag values.
Under Function, select the display variable you want to show.

7. Optional. Under Caption, select the value to display when the statistic applies to only one search
result.

Example If a Maximum statistic displays the invoice with the highest amount, and you want to quickly
display the user name of the user who last viewed the invoice, you can use the Caption column to
select the Last Viewed By user.

8. Optional. To reorder the statistic, click the Move Up or Move Down button until the statistic reaches
the desired position.
9. Click OK.
The statistic appears below the grid in the Preview pane.
10. Inthe Preview pane, click the Run button to test the statistic's performance.

Add a statistic for a string value

You can add a non-case sensitive Count statistic that distinguishes string values, such as a task template or
drawer name. To add a statistic for a string value, which you can add at the view or filter level, perform the
following steps.

Prerequisite Before you can add a statistic for a flag custom property value, you must add the flag custom
property column to the view.

2. Inthe Preview pane, click the Statistics button.

3. Inthe Statistics dialog box, click Add.

4. Under Label, type a label that describes the statistical function to appear in the search results grid.
Example If adding a statistic to count the number of items scanned by the department manager, type
Scanned by Manager

5. Under Column, select the view column with the string values.

6. Under Function, select Count.

Note: Count is the only statistical function for string values.

7. Under Variable, type the value for the statistic, such as the drawer name or task template name.

8. Optional. Under Caption, select the value to display when the statistic applies to only one search
result.

Example If there is only one items for a specific vendor in your workflow process, and you want to
quickly determine if it is an invoice or a purchase order, you can use the Caption column to show the
Document Type.



Optional. To reorder the statistic, click the Move Up or Move Down button until the statistic reaches
the desired position.

10. Click OK. The statistic appears below the grid in the Preview pane.
11. Inthe Preview pane, click the Run button to test the statistic's performance.
Modify a statistic

To modify the components of a statistic defined for a view, complete the following steps.

4.
5.

In the Preview pane, click the Statistics button and then, in the Statistics dialog box, click the row of
the statistic you want to change.

Do one of the following actions.

« Tochange the statistic definition, highlight the statistic row and then modify the components you
want to change.

« Toreposition the statistic, click Move Up to move it ahead of the preceding statistic, or click Move
Down to move it after the following statistic.

Click OK.
In the Preview pane, click the Run button to test the statistic's performance.

Remove a statistic

To remove a statistic from a view, complete the following steps.

2.
3.
4.

In the Preview pane, click the Statistics button.
In the Statistics dialog box, click the row of the statistic you want to remove and click Remove.
Click Yes in the confirmation prompt and then, in the Statistics dialog box, click OK.

Result Removing a statistic does not remove the column from the view.
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